
 
Fission 1.6.9 Manual

 
Fission v1.6.9 

www.rogueamoeba.com

Welcome! 
   Welcome to Fission, Rogue Amoeba's streamlined audio editor! This page provides a basic look at
Fission. Read it over, then have a look at the tutorials and the rest of the manual for more information.
If that sounds dull, you can dive right in to Fission and refer back to the manual for help.

Fission Overview 
   Fission is an audio editor designed with simplicity in mind. Using Fission, you can quickly and easily
trim and split MP3, AAC, Apple Lossless and AIFF files, with no quality loss. Cut one large audio file into
multiple files, or to remove sections of audio from a file. There's no need to shell out big bucks for
simple audio editing - Fission was created to make simple audio editing fast and affordable!

New in 1.6.9

CPU usage during playback has been reduced, and a half-dozen other minor bugs have been
corrected.

New in 1.6 
+ Built-in iPhone ringtone saving 
+ The Insert Silence option enables you to insert periods of silence into a file 
- The new Set Playhead command allows you to specify an exact timestamp for the playhead 
- Now uses Sparkle for easy software updates 

http://www.rogueamoeba.com/


- Almost two dozen additional improvements and bug fixes

Fission's Key Features 

Lossless Editing 
With Fission's lossless editing of AAC, MP3, Apple Lossless, and AIFF files, you can edit audio with zero
loss in quality. 

Complete Control 
Fission 1.5 provides full audio insertion support. You can now copy and paste audio from other files,
move audio around within a single file, and even merge multiple files. 

Quick Snips 
Fission is designed to enable you to quickly remove undesired audio from any file. Trim out silence from
audio files or removing commercials from recordings. 

Splits and Smart Split 
Fission can quickly break a long audio file up in to multiple files by inserting splits and saving the audio.
Better still, Fission's Smart Split tool allows you to rapidly find silence in-between tracks and save
multiple files. 

Goes Great With... 
Fission is the perfect editing companion to Audio Hijack Pro, or any other recording tool. Fission will
help edit almost any audio you have.

System Requirements

A Macintosh computer
Mac OS X 10.5 or higher

Installation And Removal 
To install Fission, just drag it from your download folder to your Applications folder, or wherever you'd
like to keep it. 

To remove Fission, simply place it in the Trash.

Purchasing 
   We provide a free trial of Fission for you to test. In its trial state, the quality of audio saved with
Fission is intentionally degraded with a series of audio fades. The full version of Fission can be
unlocked with a license key purchased from our online store. 

When you're ready, head over to http://www.rogueamoeba.com/store/ to purchase Fission for just $32.

Contact 
   Web: http://www.rogueamoeba.com/ 
   Support: http://www.rogueamoeba.com/support/ 
   E-Mail: fission@rogueamoeba.com 
   Purchase: http://www.rogueamoeba.com/store/

Getting Started With FissionGetting Started With Fission
Fission is useful for many tasks, but its basic functionality can be summarized in a few paragraphs. Read
on for more details on the basic features of Fission.

http://www.rogueamoeba.com/audiohijackpro/
http://www.rogueamoeba.com/store/
http://www.rogueamoeba.com/
http://www.rogueamoeba.com/store/
mailto:fission@rogueamoeba.com
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Once you open a file, you'll see Fission's main window. From here, you can access almost all of Fission's
features.

Removing Audio 
The most basic action in Fission is cutting out pieces of an audio file. To do this, make a selection and
then click the Remove button. This will remove the selected audio. 

Using Remove & Split will insert a split point where the audio was removed. This creates multiple clips
and thus multiple files when the audio is saved. 

If you make a selection and then click Crop, all audio outside of the selection will be removed.

Inserting Audio 
In addition to removing audio, Fission can insert audio in several ways. You can copy and paste audio
around a single file, copy audio from one file to another (even between audio formats), or drag and drop
a file from the Finder to append it to an open file. 

Copy and Paste 
Within a single file, you can re-arrange or duplicate audio. Simply make a selection, then select Copy
from the Edit menu to place it on the clipboard. Move the playhead to your desired insertion point in
the file, then select Paste from the Edit menu to place the audio. 

Combine Audio Segments 
You can also copy audio from one file, then paste it into another file. Select and copy audio from your
first file, then open the second file. Move the playhead to the desired insertion point, then select Paste
from the Edit menu and Fission will place it in. If the pasted audio does not match the format of the
open file, Fission will convert it. 

Drag & Drop 



When you want to join two files, you can also drag a file from the Finder to an open window. Fission will
then append the audio from the dragged file to the end of the open file.

Splitting Files 
To split one audio file into multiple files, use Split mode to manually insert split points anywhere in the
file. This will create multiple clips, which will then result in multiple files when you save the audio. 

You can also use the Split At Playhead command in the Clips menu to insert a split point exactly where
the playhead is. You can even use the Smart Split tool to have Fission intelligently place split points
based on silence found in the file.

Editing ID3 Tags 
With Fission's Inspector, you can adjust the ID3 tags associated with the selected audio. These tags
allow you to add metadata to the file, such as artist and track information, and will then be read by
audio players like iTunes and iPods.

Fading Audio 
Fission can be used to fade audio in or out, enabling you to create a more pleasing listening experience.
Select audio, then use the Fade In or Fade Out buttons to fade over the entire selection.

Adjusting Volume 
The volume of audio may be adjusted in two ways with Fission, with manual gain adjustment or with the
Normalize function. 

The Gain Adjustment button

Manual Gain Adjustment 
When audio is selected in Fission, the Gain Adjustment button (as seen above) will appear. Clicking it
brings up the Gain Adjustment slider. Audio can then be set anywhere between silence and full volume. 

The Normalize button

Normalize 
Normalize increases the gain of the selected audio, so that the loudest sample is at set to the maximum
possible value. Simply put, this makes the selection as loud as possible without causing distortion. Select
audio, then click the Normalize button (as seen above) to normalize the selection.

Further Instruction 
That's really it for the basic operations of Fission. You can learn more about many of these operations in
the Tutorials section, as well as the articles in Advanced Topics. Fission really is quite simple to use, so
while rading the manual is always a good idea, you may just want to dive right in.

TutorialsTutorials
This section of the Help will aid you in getting started with Fission. The following tutorials will assist you
in getting started. Follow along 

-Removing Audio - Use Fission to remove portions of audio, such as commercials, from a file. 

-Inserting Audio - Fission can also move and add audio to files. 

-Splitting Files - Fission can split long files up rapidly and, with Smart Split, intelligently. 

-Adjusting Volume - Using Gain Adjustment and Normalize, you can change the volume levels of your
audio with Fission.

Removing AudioRemoving Audio

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/tutorials.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/AT-intro.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/removingTut.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/insertingTut.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/splittingTut.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/volumeadjustmentTut.html


Fission can be used to cut out pieces from an audio file. This is useful for removing commercials from a
recording, as well as cutting out any other undesired audio.

Removing audio is quite simple. Click Select to enter Select Mode, then select the audio you wish to
remove by clicking the waveform. You can adjust a selection by dragging its edges in or out.

Remove 
Once your audio is selected, clicking the Remove button will remove the selection. The audio on either
side of the selection will be merged.

Remove & Split 
If you wish to create multiple clips after removing audio, use Remove & Split. This will remove the
selected audio and replace it with a split point, leaving you with two distinct clips.

Fades 
When removing audio, Fission will fade in and out of the cut by 1.0 seconds by default. This prevents
cuts from being too jarring when the surrounding audio is merged. The fade setting can be adjusted with
the Fade Around Removed Audio preference in the Preferences window, and toggled on or off in the Clip
menu (Fade Around Removed Audio).

Run-Through 
Let's run through the steps to remove portions of a file. 

Step 1) Open your audio file and enter Select mode. 

Step 2) Select the audio you wish to remove, by clicking and dragging in the waveform. 

Step 3) Once you have the audio selected, click Remove to remove the audio. 



Step 4) Save the audio out by clicking Save Audio. You'll get a file or files with just the audio you want!

Inserting AudioInserting Audio
Fission can move and insert audio in several ways. Audio can be copied and paste around a single file,
copied from one file to another (even between audio formats), or dragged and dropped from a file in the
Finder.

Copy and Paste 
Within a single file, you can re-arrange or duplicate audio. Simply make a selection, then select Copy
from the Edit menu to place it on the clipboard. Move the playhead to your desired insertion point in
the file, then select Paste from the Edit menu to place the audio.

Run-Through 
Let's run through the steps to copy and paste audio around a file. 

Step 1) Open your audio file and enter Select mode. 

Step 2) Select the audio you wish to copy by clicking and dragging in the waveform. 

Step 3) In the Edit menu, select Copy to copy the audio to the clipboard (if you wish to duplicate
audio), or Cut to copy the audio to the clipboard and remove the current selection (if you wish to move
audio). 

Step 4) Drag the playhead to the desired location, then select Paste from the Edit menu to paste the
audio in. 

Step 5) Save the audio out by clicking Save Audio. 

Combine Audio Segments 
You can also copy audio from one file, then paste it into another file. Select and copy audio from your
first file, then open the second file. Move the playhead to the desired insertion point, then select Paste
from the Edit menu and Fission will place it in.* 

* If the pasted audio does not match the format of the open file, Fission will convert it. This may cause quality loss.

Run-Through 
Let's run through the steps to combine audio from two different files. 

Step 1) Open your source audio file and enter Select mode. 

Step 2) Select the audio you wish to copy by clicking and dragging in the waveform. 

Step 3) In the Edit menu, select Copy to copy the audio to the clipboard. 

Step 4) Open the destination audio file. 



Step 5) Drag the playhead to the desired location, then select Paste from the Edit menu to paste the
audio in. 

Step 6) Save the audio out by clicking Save Audio. 

Drag & Drop 
When you want to simply join two files, you can drag a file from the Finder to the end of the open
window. Fission will then append the audio from the dragged file to the end of the open file.* 

* If the appended audio does not match the format of the open file, Fission will convert it. This may cause quality loss.

Run-Through 
Let's run through the steps to join one file to another. 

Step 1) Open your first audio file in Fission. 

Step 2) Find the second audio file in the Finder, and drag it to the open window in Fission. Fission will
automatically append the second file to the first. 

Step 3) Once you've got the audio position where you'd like, remove the split point by clicking to
highlight it, then pressing the Delete key to remove it. The audio will now be merged. 

Step 4) Save the audio out to one file, by clicking Save Audio. 

Inserting Silence 
To insert a period of silence, just position to playhead where you wish silence to be inserted, then select
Insert Silence from the Clip menu. Specify the desired duration of silence, and it will be appended from
the playhead on.

Run-Through 
Let's run through the steps to insert silence. 

Step 1) Open your audio file in Fission and position the playhead where you wish the silence to begin. 

Step 2) Select Insert Silence from the Clips menu. 

Step 3) Enter the desired duration for your silence, then click Insert. The silence will be inserted from
the playhead on.

Splitting A FileSplitting A File
If you have a long audio file, such as a recording of a radio program, or an imported album, you may
wish to divide it into shorter files. Fission enables you to split your file up quickly, easily, and with no
loss in quality. Splits can be done manually, or using the Smart Split tool.

Manual Splits



Above, you can see three split points at around 8:00, 10:30 and 18:00. These split points have created
four separate clips. When the audio is saved out, each clip will be saved as a separate file. This is very
useful for breaking a long file into multiple smaller and shorter files. 

Inserting Split Points 
There are two ways to insert split points and create clips. The most accurate method is to play the
audio, then pause when you reach the portion at which you wish to split. Use the arrow keys to move
the playhead in small increments forward and back, and the space bar to pause the playback. Once you
reach the desired spot, use the Split At Playhead option to insert a split point exactly where the
playhead is located. 

Alternately, you can enter Split mode and click the waveform or the ruler wherever you wish to place a
split point. You can then move the split point by clicking it and moving it with the mouse. 

Removing Split Points 

To remove a split point, simply highlight it by clicking either of the triangles on its end. Once
highlighted, just click Delete on your keyboard to remove the split point and re-merge the two clips.

Run-Through 
Let's run through the steps to manually split a file into multiple files. 

Step 1) Open your audio file and enter Split mode. 

Step 2) Insert splits at the desired points. Play the audio, then pause at the desired point and use the
Split at Playhead option in the Clips menu to insert a split point. Alternately, simply click the waveform
or the ruler where you wish to place a split point. You can move split points by dragging them. 

Step 3) When you've placed all your split points and have checked your clips, save the audio out with



the Save Audio button. Now you'll have multiple files, one for each section. Enjoy!

Smart Split

Fission's Smart Split feature looks for "silence" in the audio file, as defined by the settings. When you
click the Split button split points will be inserted at these locations. This will create multiple clips in the
file, which can be tweaked if needed. When the audio is saved out, a separate file will be created for
each clip.

In the above image, you can see Smart Split in action, working on a file imported from a vinyl record.
The green lines visible in the main window are suggested split points. Smart Split will insert 12 splits
with the current settings, creating 13 clips, one for each track on the record.

Presets 
Smart Split's presets are useful for Analog recordings such as those from records and tapes (which will
likely have more line noise during "silence"), as well as Digital recordings where silence needs to be
more strictly defined. These presets are merely a starting point - you can then adjust the controls as
needed. Once you find settings that work, you can also add your own Presets for future use.

Controls 
Smart Split's two controls will adjust exactly what Smart Split considers to be "silence". 

Length 
The length setting determines the length a section needs to be in order to be considered silence.
Increasing this value will cause fewer silences to be found, as well as preventing brief lulls in audio from
being considered silence. 

Sensitivity 
The sensitivity setting adjusts how soft the audio needs to be in order to be considered silence.
Decreasing the sensitivity will result in more silences being found.

Run-Through 
Let's run through the steps to use Smart Split on a file. 

Step 1) Open your audio file and access the Smart Split window from the Tools menu. 

Step 2) Adjust the settings and watch the main window. Here, you'll see the split points that will be
inserted once you click Split. 

Step 3) Click Split, and then have a listen to each clip. The Preview Beginning and Preview End options
in the Playback menu will be helpful here. Move, adjust, or delete splits as needed. 



Step 4) Save the audio out, and you'll get a file for each clip as seen in the main window. You're done!

Adjusting VolumeAdjusting Volume
Fission enables you to losslessly adjust the volume of audio files in two ways, with manual Gain
Adjustment as well as the Normalize function.

Gain Adjustment

The Gain Adjustment button

Selecting audio causes the Gain Adjustment button to appear. Clicking it brings up the Gain Adjustment
slider (seen below). Using this slider, the volume of the audio can be set all the way down to silence or
up to the maximum possible value. 

The Gain Adjustment slider

Run-Through 
Let's run through the steps to adjust the volume of a selection. 

Step 1) Open your audio file and enter Select mode. 

Step 2) Select the audio you wish to adjust by clicking and dragging in the waveform. 

Step 3) Once you have the audio selected, click the Gain Adjustment button, then drag the slider up or
down to adjust the volume level. 

Step 4) Save the audio out by clicking Save Audio. You're all set!

Normalize

The Normalize button

Normalize increases the gain of the selected audio, so that the loudest sample is at set to the maximum
possible value. Simply put, this makes the selection as loud as possible without causing distortion. Select
audio, then click the Normalize button (as seen above) to normalize the selection.

Run-Through 
Let's run through the steps to normalize a selection. 

Step 1) Open your audio file and enter Select mode. 

Step 2) Select the audio you wish to normalize by clicking and dragging in the waveform. 

Step 3) Once you have the audio selected, click the Normalize button in the toolbar or choosing
Normalize Selection from the Clip menu. 



Step 4) Save the audio out by clicking Save Audio. You're all set!

Fission InterfacesFission Interfaces
   This section of the Help gives details on what each piece of Fission does. 

-Main Window - An overview of Fission's main window. 

-Secondary Control Windows - These secondary control windows of Fission contain additional controls. 

-Save Panel - Fission's Save Panel enables lossless saving, as well as saving in other formats through
QuickTime. 

-Other Windows - Information on the other minor windows in Fission is found here. 

-Menu Reference - This section explains what each and every menu item does in obsessive, boring
detail.

Main WindowMain Window

The main window seen above houses all of Fission's main settings. From here, all of Fission's primary
controls can be accessed.

Fission's Modes 
Fission has three distinct modes for affecting audio files, selectable from the toolbar at the top of
Fission's window.

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/main.html
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http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/otherwindows.html
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Inspect Mode 
When in Inspect Mode, you can examine clips and files. Select audio to be played back or adjusted with
the Inspector. 

Select Mode 
Use Select Mode to select portions of audio. This audio can then be cropped around, cut, or faded. 

Split Mode 
Split Mode is used to insert Split Points into the file. When the audio is then saved, each split point will
cause a separate file to be created.

Editing Controls 
Fission's Editing controls enable you to remove and adjust audio as described below.

Remove 
Clicking Remove will remove the selected audio. 

Remove & Split 
Remove & Split will remove the selected audio, and leave a split point. This will create two clips and two
files when the audio is saved. 

Crop 
Crop removes all the audio outside of the current selection, leaving only the selected audio. 

Fade In 
Fade In will fade audio in over the entire selection, ramping up the volume to the end of the selection. 

Fade Out 
Fade Out will fade audio out over the entire selection, ramping down the volume to the end of the
selection. 

Normalize 
Normalize will increase the gain of the entire selection, so that the loudest sample is at the maximum
possible value. Simply put, this makes the selection as loud as possible without causing distortion.

Control Buttons 
The Inspector button toggles the visibility of the Inspector. The Save Audio button opens the Save
dialog to save the audio out.

Main Editing Area 
Fission's main editor consists of two waveforms showing your audio visually. The top waveform shows
the entire file at once, while the bottom provides a larger, zoomed-in view.



Above you can also see the read playhead, showing where audio is playing, as well as the two rulers
(on the top and the bottom) showing the timestamps. 

The Gain Adjust controller (shown above) can be whenever audio is selected. Click this, then drag the
slider up and down to adjust gain of the selected audio.

To adjust the zoom level of the main waveform, use the zoom slider. Clicking the - or the + buttons on
the end will zoom out or in by one step, respectively.

Playback Controls 
When playing audio in Fission, you can control playback with these controls.

The timer wells show the time elapsed and time remaining. Use the rewind, play/pause, and fast
forward controls to move the playhead, and the volume control to adjust the output volume during
playback.

Secondary WindowsSecondary Windows
   The secondary windows in Fission provide access to additional controls.

Inspector Area 



   The Inspector area allows access to information on the file or clip selected, as well as ID3 tag editing.
ID3 tags display in most media players when a file is played, to show information such as the title and
artist for a song. Edit tags for the selected clip here, and when the file is saved, these tags will be
added as well.

Smart Split Window 

   This window provides access to Fission's Smart Split functionality. This allows a file to be split into
multiple clips, based on silence found in the file. 

   As the controls here are adjusted, suggested splits will appear in the Main window. Click the Split
button to accept and place these split points, creating multiple clips. When the audio is saved, multiple
files will be saved, one for each clip.

Save PanelSave Panel



Fission's Save panel is accessed by clicking the Save Audio, and controls how audio is saved after
editing.

 
Fission's Save Panel

When editing an MP3, AAC, Apple Lossless, or AIFF file, you should generally choose the first option
here. This will save the new files in the same format as your original audio, without any quality loss.

If you wish to save the audio to another format, choose the Export With QuickTime options. This will
enable you to save in any audio format supported by your QuickTime installation.

Other WindowsOther Windows

Help Window 
   This displays the Fission Manual, and can be accessed by pressing Command-? or choosing 'Fission
Help' from the Help menu.

Registration Window 
   As seen above. Click 'Enter License' to enter a license key for Fission, which may be purchased from
our store, then click Print to make a copy for safekeeping. If you don't own a license key, click Buy to

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/buyme.html


purchase. If you've lost your license, click the 'I Lost My License' button.

Welcome Panel 
   The Welcome panel appears when Fission is launched. It shows a helpful tip of the day, as well as
providing access to the open files dialog, and browse for files from common locations. From here, you
can choose to open an audio file, browse from common locations, or open the Fission manual. Once you
open an audio file, you'll see the main window, as shown below. 

You can turn off the Welcome panel in Fission's preferences.

About Window 
   Displays the credits for Fission.

Menu ReferenceMenu Reference
   The following is a list of the relevant menu items in Fission including a short description of each item's
function.

Fission Menu 
About Fission - Shows Fission's credits 
Check For Update - Checks via the Internet for updates to Fission 

Preferences... - Opens Fission's Preferences window 
License... - Opens Fission's License window 

Hide Fission - Conceals all of Fission's windows 
Hide Others - Conceals all other applications 
Show All - Reveals all other applications 

Quit Fission - Quits Fission

File Menu 
Open... - Shows the Open dialog 

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/prefs.html


Open Recent - Shows recently used files for quick access 
Browse Files - Enables access to audio files in iTunes, via a Spotlight search, or in Audio Hijack Pro's
recordings folder 

Close - Closes the current file 
Revert to Original - Reverts to the original version of the file, removing all changes made since last
saving 

Save Audio... - Opens the Save dialog to save changes 
Save Selection... - Saves just the selected audio 
Save Cue Sheet... - Saves a cue sheet along with the current audio file 
Save as iPhone Ringtone - Saves as a ringtone for use with the iPhone, passing the file off to iTunes.

Edit Menu 
Undo - Allows the previous actions to be Undone 
Redo - Allows previously Undone actions to be Redone 

Cut - Removes the selection and places it on the clipboard 
Copy - Copies the selection to the clipboard 
Paste - Pastes the contents of the clipboard 
Delete - Deletes the current selection 
Select All - Selects all audio in a window or text in a field 
Deselect - Deselects, leaving no audio or text selected 

Copy Tags - Copies all tags from the currently selected clip onto the clipboard 
Paste Tags - Pastes all tags from the clipboard onto the currently selected clip 

Clear All Splits - Removes all split points from the current file

Tools Menu 
Inspect Mode - Enters Inspect Mode, to allow ID3 tag editing and clip inspection 
Select Mode - Enters Select Mode, to select audio for Cropping, Cutting and Fading 
Split Mode - Enters Split Mode, to insert Split points 

Smart Split... - Opens the Smart Split panel 

Set Selection... - Brings up the Set Selection sheet, to set a selection by exact time stamps 
Add Split... - Brings up the Add Split sheet, enabling a split to be added by timestamp 

Apply Cue Sheet... - Shows the Open dialog to select a cue sheet to apply to the existing audio file 

Zoom In - Zooms the waveform view in 
Zoom Out - Zooms the waveform view out 
Zoom to Selection - Zooms the waveform to the selected audio

Playback Menu 
Play/Pause - Toggles playback of audio 
Scan Forward - Moves the playhead forward in small increments 
Scan Backward - Moves the playhead backward in small increments 

Play Selection Only - When this option is active, playback will apply only to selected audio 
Loop Playback - When selected, playback will loop 

Preview Beginning - Plays the first second of audio 
Preview End - Plays the last second of audio

Clip Menu 
Select Next Clip - Highlights the next clip 
Select Previous Clip - Highlights the previous clip 

Select Next Tab - When the Inspector is visible, switches to the tab to the right. 
Select Previous Tab - When the Inspector is visible, switches to the tab to the left. 



Remove - Removes the currently selected audio 
Remove & Split - Removes the currently selected audio and inserts a Split point 

Crop - Removes all audio not contained in the current selection 

Fade Around Removed Audio - Toggles the application of the "Fade Around Removed Audio"
preference 

Split at Playhead - Inserts a split point at the playhead's location 

Fade Selection In - Fades the currently selected audio in 
Fade Selection Out - Fades the currently selected audio out 

Normalize Selection - Normalizes the selected audio, increasing its volume to make it as loud as
possible without distortion 

Insert Silence... - Inserts the specified duration of silence where the playhead is located.

Window Menu 
Zoom - Zooms the foremost window 
Minimize - Minimizes the foremost window to the Dock 

Show/Hide Toolbar - Toggles the visibility of the Toolbar in the main Fission window. 
Customize Toolbar... - Allows adjustment of options found in the Toolbar in the main Fission window. 

Show/Hide Inspector - Toggles the visibility of the Inspector 

Bring All to Front - Brings all of Fission's windows to the foreground.

Help Menu 
Fission Manual - Opens this help window 
Contact Support... - Opens an in-application form that directly sends email to us for support 

Visit RogueAmoeba.com... - Takes you to our homepage 

Purchase Fission - Opens the Rogue Amoeba Store to purchase Fission.

PreferencesPreferences

Audio Settings:Audio Settings: 
   Fade around removed audio: - This setting adjusts the length of audio faded in and out when
removing a section of audio from a file. Set to 0.0 for Off. 

   Play audio through: - This setting adjusts the output device through which audio from Fission plays. 

   Audio Scrubbing: - With this preference on, audio near the cursor will play when the cursor is



   Audio Scrubbing: - With this preference on, audio near the cursor will play when the cursor is
moved.

At Startup:At Startup: 
   Show Welcome Panel: - This setting casues the Welcome panel to display on launch, including easy
access to major functions as well as helpful hints. 

   Automatically check for updates: - With this on, Fission compares its own version number with the
most current version available from our server. Leave this on to stay up-to-date.

Hidden FeaturesHidden Features
Fission has a great many features, some of which can be a bit difficult to find. Read this over for some
of the lesser-known features of Fission

DebuggingDebugging

The Debugging dialog can be accessed by holding down the option key as Fission launches. If a problem
occurs, these debugging options may show what's wrong.

Hidden PreferencesHidden Preferences

In the name of simplicity, not all of Fission's preferences are accessible from within the application.
Some prefs can only be accessed through the "defaults" system in the Terminal or by editing the
preferences file (~/Library/Preferences/com.rogueamoeba.Fission.plist) by hand. 

disableSaveWarning: This preference toggles the appearance of the Save Warning when closing a file
in Fission. 

The example command below for the Terminal will prevent the Save Changes warning from appearing. 
defaults write com.rogueamoeba.fission disableSaveWarning -bool YES 

limitSmartSplits: This preference toggles a limiter placed on the number of splits found by the Smart



Split window. By default, this window is limited to finding 100 splits. Removing this limit will allow the
Smart Split window to find more splits, but can slow the program or cause it to crash. 

The example command below for the Terminal will cause the Smart Split limiter to be deactivated. 
defaults write com.rogueamoeba.fission limitSmartSplits -bool NO 

registrationObscured: This preference controls the visibility of the registration code in the Registration
window. If you're in a group environment, you may wish to obscure this code to prevent theft. 

The example command below for the Terminal will cause the code to be obscured in the Registration
window. 
defaults write com.rogueamoeba.Fission registrationObscured YES 

initialZoomFactor: This preference controls the zoom factor for newly opened files. By default, new
windows open at 2x zoom. 

The example command below for the Terminal will cause new documents to open at 32x zoom. 
defaults write com.rogueamoeba.Fission initialZoomFactor 32

Purchasing FissionPurchasing Fission
Quick Link: To buy a license key for Fission, visit our online store.

Why Should I Buy Fission?Why Should I Buy Fission? 
Put simply, you should buy Fission because it isn't free - we give you a chance to test out the program
and all its features before you buy it. It's like test driving a car, for as long as it takes you to decide. 

In trial mode, all of Fission's features are available to try, but it won't work for full-time use. Until you
purchase, the quality of audio saved through Fission will be degraded through a series of audio fades. 

If you use Fission and find you like it, please purchase a license key and support Rogue Amoeba. You'll
be allowing us to continue to bring some of the world's best software products into existence.

What does Fission cost?What does Fission cost? 
Fission is available for purchase the world over for just $32. Our prices are so low, they're affordable! 

If you need to record audio from a mic or an application, try out Audio Hijack Pro. You can purchase the
Audio Hijack Pro + Fission bundle for just $50!

How do I buy Fission?How do I buy Fission? 
To purchase your license key, just visit http://www.rogueamoeba.com/store/.

What types of licenses do you offer?

We have two types of licenses, Single-user and Family Pack. 

• Single-user licenses are for a single user on one or more personal machines. 
• Family Packs are for up to five users in a single household, on one or more personal machines. 
• Family Packs are not valid for use by businesses. Businesses and organizations can save with our
volume discounts, available automatically with quantities of 10 or more.

After PurchaseAfter Purchase

http://www.rogueamoeba.com/store
http://www.rogueamoeba.com/store/


How does purchasing work?How does purchasing work? 
When you purchase through our store, you'll immediately receive a license key in your browser, as well
as via email. This key will allow you to unlock the full version of Fission. Simply enter your key into
Fission as instructed, and you'll be all set.

Can I use my license key on multiple machines?Can I use my license key on multiple machines? 
A license key for Fission provides 1 "seat". This allows for a single copy to be in use at one time. If you
own multiple personal machines, you may install and unlock Fission on them, provided it is only in use
on one machine at a time. If you need to use Fission simultaneously on multiple machines, you'll need
to purchase multiple license keys.

What's your upgrade policy?What's your upgrade policy? 
Rogue Amoeba doesn't have a stated upgrade policy, just a great track record. Since 2002, we've
provided hundreds of free updates across our entire product line. These updates have fixed bugs and
added new features. If we add substantial new functionality, we may charge an upgrade fee. However,
we do not make most of our income from upgrades, and we provide nearly all updates free of charge.
Buy with confidence!

What's your refund policy?What's your refund policy? 
All Rogue Amoeba products are available as demos for an evaluation prior to purchase. We believe that
no customer should have to buy software in order to find out how well it works. Our software can be
fully evaluated with no limitations in capabilities, prior to purchase. Customers are strongly
encouraged to take advantage of these trials prior to purchase. You may also seek any needed
technical support from us - we answer support emails rapidly and responsively for current and potential
customers alike. 

If you would like a refund, please contact hello@rogueamoeba.com within 14 days of your purchase.
Because we can not recover the license key that was sold, refunds are issued on a case-by-case basis.

Cross-PromotionCross-Promotion

 
Audio Hijack Pro

Recording Audio With Audio Hijack ProRecording Audio With Audio Hijack Pro 
Fission enables you to edit audio you already have. If you also need to record audio, have a look at
Audio Hijack Pro. Record any audio with Audio Hijack Pro, from microphones and other audio devices, as
well as software applications like RealPlayer and more.

Bundle UpBundle Up 
Audio Hijack Pro costs just $32. Better still, when you purchase Audio Hijack Pro and Fission together,
the bundle costs just $50!

So how do I buy Audio Hijack Pro?So how do I buy Audio Hijack Pro? 
To purchase a license key for Audio Hijack Pro, just visit http://www.rogueamoeba.com/store/ and
follow the instructions there.

Advanced TopicsAdvanced Topics
   The following pages provide advanced instruction on various topics. 

-Keyboard Shortcuts - Fission has many keyboard shortcuts for speeding up your workflow. 

-Creating Non-iPhone Ringtones - Fission is great for creating ringtones for your cell phone. 

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/hello@rogueamoeba.com
http://www.rogueamoeba.com/audiohijackpro/
http://www.rogueamoeba.com/store/
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/AT-keyboardshortcuts.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/AT-ringtones.html


-Cue Sheets - New in Fission 1.5 is support for working with cue sheets.

Fission's Keyboard ShortcutsFission's Keyboard Shortcuts
As you use Fission more, you may wish to access its features faster. Fission's keyboard shortcuts can
help you do this. The following shortcuts will get you editing your audio faster than ever.

Basic ControlsBasic Controls 

Command-=: Works the same as Command-+, to zoom in. 
Delete/Backspace: Removes the selected Split, or Cuts the selected audio. A Split Cut will occur if the
selected audio contains a split. 

Space: Toggles play/pause 

Home & End: Moves the playhead to the beginning or end of the file 

Arrow keys: Moves the playhead, split or selection, as described below.

Arrow KeysArrow Keys 
The left and right arrow keys are very useful for navigating a file and adjusting the current selection. 

Playhead movement: 
No modifier keys: The playhead will be moved by approximately .2 seconds. 
While holding Option: The playhead will be moved by exactly a single packet. 
While holding Command: The playhead will be moved to the specified end of the file. 
While holding Control: The playhead will be moved to the next split in the specified direction, or to
the end of the file if no further split points exist. 

Split movement: 
No modifier keys: The selected split will be moved by approximately .2 seconds. 
While holding Option: The selected split will be moved by exactly a single packet. 

Selection movement: 
No modifier keys: The selection will be moved by approximately .2 seconds. 
While holding Option: The selection will be moved by exactly a single packet. 
While holding Shift: The selection will be expanded in the specified direction. 
While holding Shift+Command: The selection will be decreased in the specified direction.

Selecting AudioSelecting Audio 
Keyboard shortcuts can be used to make a selection. Pressing 'i' will set the selection to the playhead's
current location. You can then move the playhead with the arrow keys, and press 'o' to expand selection
to the area that the playhead has moved over. 

Quick steps to select audio with the keyboard: 
   1. Move the playhead to one end of your desired selection. Press 'i' on your keyboard to start the
selection. 
   2. Use the forward and back arrow keys to move the playhead to the other end of the desired
selection. 
   3. Press 'o' on your keyboard to finish the selection. Your audio will now be selected.

Creating iPhone RingtonesCreating iPhone Ringtones
If you've got an iPhone, Fission can turn any audio file into a ringtone for it, by editing and passing it
off to iTunes.

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/AT-cuesheets.html


With Fission, you can take any audio file you already own and create a short ringtone from it. To do this,
you'll open your audio file in Fission then select the audio you want for the ringtone. To find the exact
audio you want, use the playback controls and adjust your selection by dragging the edges.

Once you have your audio selected, use the Crop function to trim out the unwanted audio. Play the
audio to confirm it's what you want, and you're nearly done! Just click Save as iPhone Rington, and
Fission will convert the audio to AAC (if needed) then send it over to iTunes. iTunes will then interpret
the file as a Ringtone, and you'll be able to sync it over to your iPhone or iPod Touch for use there.
Enjoy!

Run-Through 
Let's run through the steps to create a ringtone: 

Step 1) Open your original audio file. 

Step 2) Using Select mode and the playback controls, select the portion of the audio you want to use
for your ring tone. 

Step 3) With your desired audio selected, click the Crop button to remove all other audio. 

Step 4) Save the ringtone by clicking Save as iPhone Ringtone. Fission will automatically convert the
file to AAC and pass it off to iTunes to turn it into a ringtone. It's now ready for syncing to your iPhone!

Creating Non- iPhone RingtonesCreating Non- iPhone Ringtones
Why pay $2.99 to get a ringtone of a song you already own? If your phone supports MP3 or AAC
playback, you can make your own ringtones using Fission!



With Fission, you can take MP3 or AAC files you already own and create a short ringtone from it. To do
this, you'll open your audio file in Fission then select the audio you want for the ringtone. To find the
exact audio you want, use the playback controls and adjust your selection by dragging the edges.

Once you have your audio selected, use the Crop function to trim out the unwanted audio. Play the
audio to confirm it's what you want, and then save the audio out by clicking Save Audio. Be sure to
save in a format compatible with your cell phone - MP3 will work on many new cell phones, as well as
AAC. Once you have your file, transfer it to your cell phone and you're all set!

Run-Through 
Let's run through the steps to create a ringtone: 

Step 1) Open your original audio file. 

Step 2) Using Select mode and the playback controls, select the portion of the audio you want to use
for your ring tone. 

Step 3) With your desired audio selected, click the Crop button to remove all other audio. 

Step 4) Save the audio by clicking Save Audio, and choose to save losslessly. Once you have your file,
transfer it to your cell phone and you're set to go!

Cue SheetsCue Sheets



Fission 1.5 now has full support for reading and writing cue sheets to accompany audio files. Cue sheets
provide audio editing software with information about a file, allowing it to automatically perform editing
tasks on the file. This can be very useful for automating a standard editing process.

Opening Cue Sheets 
If you have a cue sheet from Fission or another editor, you can simply open it as a normal file in Fission
- drag it to the Dock icon or the Welcome window, or choose Open from the File menu. If you have an
audio file open already, you can also select Apply Cue Sheet... from the Tools menu.

Saving Cue Sheets 
To save a cue sheet with Fission, simply use Fission as normal. Place split points and enter meta-data,
then choose Save Cue Sheet... from the File menu. Fission will save the audio file in its current state,
and an accompanying cue sheet. You can then open the cue sheet in Fission at a later time or in other
editors that support cue sheets.

Licenses, Contacts and All  The Fun That InvolvesLicenses, Contacts and All  The Fun That Involves
   We now present the conclusion to the Fission Manual 

-User License - Let your lawyer explain it all to you. 

-Contact - How to get in touch with Rogue Amoeba. 

-Printable Manual - Click here for a printable version of this manual. LicenseLicense

DistributionDistribution 
   Unless explicitly stated in writing, Rogue Amoeba Software does not grant permission to sell Fission
("The Software"). Non-profit distribution of The Software in its trial form is acceptable provided that The
Software is not modified in any way, and the complete works of The Software are included in the
distribution package. If The Software is to be included in a distribution package, Rogue Amoeba requests
but does not require that one complimentary copy of said package, sent to the following address:

Rogue Amoeba Software 
Marketing Department 
29 Scottsdale Ct. #1 
Cranbury, NJ 08512

What that said: Don't sell this software directly for profit. If you want to distribute it, great! Just make
sure it's unmodified from the download from our site. If you create a distribution package, it'd be cool if
you sent a copy to the address above, though this is not required.

RefundsRefunds 
All Rogue Amoeba products are available as demos for an evaluation prior to purchase. We believe that
no customer should have to buy software in order to find out how well it works. Our software can be
fully evaluated with no limitations in capabilities, prior to purchase. Customers are strongly
encouraged to take advantage of these trials prior to purchase. You may also seek any needed
technical support from us - we answer support emails rapidly and responsively for current and potential
customers alike. 

If you would like a refund, please contact hello@rogueamoeba.com within 14 days of your purchase.
Because we can not recover the license key that was sold, refunds are issued on a case-by-case basis. 

What that said: We want you to be happy, so we enable you to test drive our software. If you have

http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/license.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/contact.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/printing.html
http://file:///Users/pxr/Desktop/Fission%20Manual.helpbundle/Contents/Resources/English.lproj/hello@rogueamoeba.com


any questions, let us know before you buy, we're happy to help. Refunds may be issued within 14 days
of purchase, at our discretion.

DisclaimerDisclaimer 
Fission ("The Software") is provided as is. Rogue Amoeba Software ("The Author") is not responsible for
any damage to the user's computer system or data and in no event will The Author, its officers,
directors, employees or agents be responsible to the user for any consequential, incidental, or indirect
damages (including damages for loss of business profits, business interruption, lost of business
information, and the like) arising out of the use or inability to use the The Software, even if The Author
has been advised of the possibility of such damages. Because some states do not allow the exclusion or
limitation of liability for consequential or incidental damages, the above limitations may not apply to
you. Further, the consumer agrees that using this software in any way illegal, or even for the purposes
of assessing its viability for illegal usage, is prohibited. 

What that said: Be safe when you use the software. Be aware that it's simply a tool designed to make
your life better. Don't use it to do illegal or evil things. If you do, be ready to take responsibility for
your own actions.

ContactsContacts
Fission Homepage 
http://www.rogueamoeba.com/fission 

Rogue Amoeba Homepage 
http://www.rogueamoeba.com 

Fission Support 
fission@rogueamoeba.com 
Be sure to look over the Known Issues page and the support center first. 

Join the Rogue Amoeba low-traffic announcement list. There's no spam, EVER. It's as simple as that. 
http://www.rogueamoeba.com/company/lists/maclist.php

Printable ManualPrintable Manual

 
To print this entire manual, download the PDF version here.
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